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About This Manual
This manual describes the features and operation of MFI View System Software (MVSS) version 5.1.2. MVSS 5.1.2 is used 
to operate MFI 5100 and MFI 5200 with Bot1 particle analysis instruments and enables the United States Food and Drug 
Administration’s Rule 21 CFR Part 11 regulation. For DPA systems, please refer to the MVSS version 3.3 User Guide as 
MVSS 5.1.2 is not compatible with these systems.

In this manual, MVSS commands and menu selections are identified using bold gray font.

Attention Phrases
NOTE 		  Points out useful information.

IMPORTANT 	 Indicates information necessary for proper operation.

CAUTION	 Cautions about potentially hazardous situations that could result in injury to you or damage 
		  to the instrument.

!WARNING! 	 Warns you that serious physical injury can result if the listed precautions aren’t followed.

Intended Use
For research use only. Not for use in diagnostic procedures.

Name and Address of Manufacturer
Corporate Office

ProteinSimple 
3001 Orchard Parkway 
San Jose, CA 95134 
Toll-free in the US and Canada: (888) 607-9692 
Tel: (408) 510-5500 
Fax: (408) 510-5599 
email: support@bio-techne.com 
web: www.bio-techne.com
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System Requirements
The following is a list of minimum computer specifications required for the operation of MVSS versions 3.1 and higher. 
Minimum computer specifications are listed below. 

Component MFI Computer Controller, MVSS Version 5.1

CPU Intel® Core i3, Dual Core

RAM 4 GB DDR3

Hard Drive (OS) 500 GB, 7100 RPM

Hard Drive (For Repository) 1 TB, 7200 RPM, SATA3, 64 MB cache

Video Card Provided through Core i3, Auto VRAM

Removable Storage Device Slim DVD Burner

Firewire Port One (1) IEEE 1394a, 6-pin powered, Firewire A

USB Ports Several USB2, and two (2) USB3 ports

Monitor 17 inch, 1280 x 1024 resolution, SXGA, 5:4 ratio

Mouse/Keyboard Mouse USB, Optical/Keyboard USB

Operating System Windows® 7 Professional (English, 32-bit) (version 5.1.2 patch tested 
on Windows 10 and Windows 10 IoT Enterprise LTSC 2021 64-bit)

MFI Computer Controller
All MFI instruments are designed to operate with an instrument PC controller that both operates the MFI 5100 and the 
MFI 5200 instruments and obtains initial data. We can only guarantee instrument performance with the instrument PC 
controller that we provide as it is validated extensively with MFI instruments to ensure that it is compatible with data 
processing and the imaging camera. PC systems ordered from ProteinSimple are verified and preconfigured before 
shipping. 

Other PC Models
ProteinSimple has experienced some communication problems between the PC and the MFI instrument when using 
computers other than the approved ProteinSimple PC that is provided with the MFI system. The ProteinSimple PC acts as 
the instrument controller in addition to providing data analysis, and only the ProteinSimple PC is validated to work with 
MFI systems. If you intend to use a non-approved PC, please contact ProteinSimple Support at support@bio-techne.com 
well before the planned installation of your system to ensure compatibility with your PC. Use of a PC not supplied by 
ProteinSimple may result in additional installation charges. Any computer supplied from another vendor will need to be 
configured on-site. 
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Software Installation

Launching the Installer
This section describes how to install MVSS 5.1.2 on an existing MFI 5100 and MFI 5200 systems with MVSS v3.1 or higher. 

NOTES:  
MVSS 5.1 is only compatible with MFI 5100 and MFI 5200 instruments, and not with DPA 4000 Series instruments. 
 
Instruments with MVSS v3.0 or earlier cannot use this procedure. Your MFI 5100 or MFI 5200 system must be using 
MVSS v3.1 or higher to upgrade to MVSS 5.1.2.  
 
Please see “Upgrading MVSS to Version 3.1 and Higher” on page 11, or contact ProteinSimple Technical Support 
for more information on how to upgrade your version of MVSS to v3.1 first. 

Install CD

To install MVSS 5.1.2 on an MFI 5100 or MFI 5200 system with MVSS 3.1 or higher, insert the CD into the CD drive. Follow 
the installation wizard instructions: 

1.	 Copy the installer to a local folder on the control computer (for example, C:\ProteinSimple).

2.	 Double-click the installer file MVSSSetup.5.1.2.exe to launch the setup.

3.	 Click Yes in the User Account Control dialog (if applicable).
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4.	 Click Next in the Welcome window.

5.	 Select I accept the terms of the License Agreement, then click Next.
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6.	 Click Next in the Choose Install Location window.

7.	 Click Next in the Choose Components window (selections will be grayed out for an upgrade).
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8.	 Click Install in the Choose Start Menu Folder window (selections will be grayed out for an upgrade).

9.	 The installer will extract the necessary files for the installation or upgrade. Users will be prompted to copy the existing 
Repository. If you have not already done this, click OK and proceed to Step 10. If you have already performed the 
necessary backup of the Repository, click Backup Already Performed, Continue… and proceed to Step 11.

10.	If you clicked OK in Step 9, the following dialog box will display confirming that the Repository is available for copying. 
Manually backup the files shown in the corresponding Windows® Explorer window to a safe location.
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11.	 The following dialog box will display confirming the continuation of the upgrade after copying the Repository. Click 
Yes.

12.	Allow the MVSS 5.1 Installer to proceed. Several windows will display indicating progress for various steps of the 
installation.

13.	When prompted, unplug the Firewire cable for the camera from the MFI instrument and then click OK.
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14.	When prompted, reconnect the Firewire cable and then click OK.

15.	Click Finish to complete the installation.

NOTE: If you are upgrading to a new version of the software, you may see an “Install error msvcr71.dII” error that 
indicates an error opening a file. This error occurs if background processes are using this common file. If this error 
occurs, close all files and programs and use the Microsoft Windows Task Manager to search for any remaining 
MVSS. exe files from the earlier installation. Remove them and then repeat the installation process.
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Upgrading MVSS to Version 3.1 and Higher

NOTE: MVSS 5.1.2 is compatible with MFI 5100 and MFI 5200 systems using MVSS v3.1 or higher only, and not 
DPA 4000 systems. For MFI 5100 or MFI 5200 systems using MVSS v3.0 or earlier, you must first upgrade to 
MVSS v3.1 or higher before upgrading to MVSS 5.1. Please contact ProteinSimple Technical Support for more 
information and review the following upgrade process.

Starting in MVSS version 3.1, the format of the data was modified to create a more stable structure. There are two methods 
to migrate from 3.0.1 to 3.1.0 and higher. If all your data has been exported and backed up, then the simplest way to 
upgrade is to reformat the drive and do a clean software installation.

IMPORTANT  
If you have not backed up your data, reformatting the drive will delete all data from the repository and you will not be 
able to recover this data from the repository once it is deleted.

The other upgrade method requires a backup of data before a complex upgrade. For an MFI system currently running 
MVSS version 3.0 or earlier, the upgrade process to MVSS version 3.1 is complex and lengthy, so the process of backing 
up and converting is a controlled release since it may not be needed or desired by all users. In some cases, a new MFI 
computer and a service support charge will be required for the upgrade.

NOTE: ProteinSimple strongly recommends that users who intend to upgrade review all instructions on the 3.1 
upgrade process with ProteinSimple Technical Support first. Due to the complexity, this upgrade process may not 
be needed or desired by users.

System upgrades from version 3.0 to version 3.1 require a full backup of all data projects and audit logs to an external 
drive, which can require up to 48 hours. A complaint and a non-compliant backup are recommended for all projects. Data 
backup is followed by conversion of project files to a new format, and then recreation of method files and user settings. 
For MFI 5100 with Bot1 or MFI 5200 systems with Bot1, the prior Bot1 methods may no longer be valid, but the new format 
provides the ability to wash the flow cell after an analysis cycle. If the backup process fails, then the user can reformat the 
drive and do a clean installation.

Overview of the MVSS v3.1 Upgrade (For systems using MVSS v3.0 or earlier)

1.	 First confirm that the repository contains all the project files you wish to have converted into a new repository format. 

NOTE: Corrupted project files will prevent conversion of the repository.
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2.	 You may backup to a network location or a 2 TB external USB drive. If you use an external drive, attach the drive and 
then back up all your data to this drive (this requires up to 48 hours).

3.	 Export your projects in complaint mode. This step will create a file for each sample run that can be converted and 
reloaded into MVSS versions 3.1 and above. We also recommend making a full backup of the data in non-compliant 
mode to save an archived copy that can be viewed with MVAS. This also provides individual JPEG image files that can 
be reviewed. A final export and deletion of the compliant data can be sent to a secondary location to ensure the data is 
backed up and all data has been saved.

When all needed data has been properly archived and deleted from the repository, you can uninstall the old version of 
MVSS. If the data is left in the repository you will not be able to uninstall previous versions of MVSS. You can reformat 
the repository drive to remove unnecessary data quickly and then uninstall MVSS.

4.	 Upgrade the MVSS version to 3.1. This version has the new method files.

5.	 Import the newly converted project files that you wish to view back into MVSS version 3.1 or higher. 

6.	 Before running samples, you will need to calibrate your pump, create methods and user accounts (if required for your 
process), optimize the illumination, and focus the flow cell. If your system has a Bot1, you will also need to calibrate the 
Bot1 Autosampler.
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Compliance
MVSS contains features that enable the United States Food and Drug Administration (FDA) Rule 21 CFR Part 11 regulation. 
This section provides an overview of the MVSS implementation of this regulation. 

MVSS File Types
File types that are used or created by MVSS are as follows:

•	 Compliant project exports created in MVSS are .data files

•	 Non-compliant files include tables in CSV format and JPEG images

•	 Particle images are .jpg files

•	 The audit trail is a .data file

•	 Log files are .data files

•	 Methods are .mthd files

•	 Reports are PDF files

•	 Batches are .batch files

•	 A batch protocol is a TSV file

The table below indicates whether each file is regulated or non-regulated (in terms of 21 CFR Part 11), whether audit trails 
are enabled for the file, and the tracking of edits, users, and data. 

File Types Regulated File Audit Trail Tracking

Raw Image No No

Raw Summary Yes Yes

Summary (Converted) No Yes (copy only)

Selective Raw Image Yes Yes

Raw Image Summary Yes Yes

Image Summary (Converted) No Yes (copy only)

Reports Yes Yes

Reports (Converted) No Yes (copy only)

Methods Yes Yes

Methods (Converted) No Yes (copy only)

Audit Trails Yes Yes (copy & archive)

Audit Trails (Converted) No Yes (copy only)

User Accounts Yes Yes

System Files No No

15

Chapter 3: MVSS - 21 CFR Part 11 Compliance  //  Compliance

MVSS User Guide



NOTE: Converted files refer to human-readable formats. Converted files will be exported to an unprotected area 
where they may be manipulated. These files are copies of the original files which are stored in binary format. Only 
the original binary files are regulated data.

Audit trails will be performed on all regulated files. The copying and exporting of files will also be recorded in the audit 
trails. Files that cannot be modified after creation (i.e. reports) will have their creation, copying, and exporting logged in 
the audit trails. MVSS does not allow deletion or modification of a method.

For every sample analysis, MVSS produces binary files, in a proprietary format, containing the analysis information and 
results. These files are stored in the secure repository and are only accessible by MVSS software.

The Export command is used to move data files from the repository to longer-term storage. Log and Audit Files always 
export in binary format and therefore can only be viewed through the MVSS View menu; however, Projects can be 
exported either in binary/CFR Compliant or Standard format. In MVSS 4.0 and higher, the user can export multiple projects 
at a time in compliant mode. To enable archiving and reduce the repository, the user can export multiple projects and 
delete them from the repository. Multiple projects can be exported by holding down control or shift when selecting the 
files in the Export Project dialog box:

The Import command is used to bring in data files that are enabled under 21 CFR Part 11. See “Import” on page 23 for 
more information.

Image Files
Image frame files stored by MVSS are in a JPG compressed format. Image frame size is approximately 140 Kb each.
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Access Control
The user access functions and permissions are configurable by the administrator. Changes to access control levels are 
logged in the audit trail.

Setting up Multiple Windows Users 
If all users will have equal access to MVSS, then the system administrator needs to grant Full Control permission for 
Everyone for E:\~~PS~~\__SystemFolder.

•	 Repository root ~~PS~~ is usually under E:\, depending on the drive selected for the repository during MVSS 
installation.

•	 ~~PS~~ and __SystemFolder, and all of its contents, must be accessible by the logged-in Windows user to run MVSS. 

•	 Make sure to select Replace all child object permissions with inheritable permissions from this object when setting 
the permission for __SystemFolder.

•	 __SystemFolder contains logins, hardware configuration, settings, batches, methods, and the audit trail.

•	 Exported data will contain the model number and serial number.

If the system administrator wants to create separate levels of access between Windows users who are using MVSS:

•	 The system administrator can set permissions on project folders or other folders inside the repository. 

•	 MVSS allows all users to import/export, and delete Batch Protocols and Methods.

Method Development
MVSS uses methods to operate the instrument. A method is created by an authorized user and defines the parameters, 
sequence of operation, and desired report formats to perform a sample analysis. The parameters that are configured 
through methods are:

•	 Hardware 

•	 Run Configuration 

•	 Image Frame Capture

•	 Morphological Filters

•	 Report Preferences

A software wizard is provided to guide users through the Create Method process. Methods are regulated data and cannot 
be revised once they are created. In MVSS v4.0 you can delete method files as well as Bot1 batch protocols.
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File Protection in MVSS
In MVSS version 3.1 and higher, the format of the data repository was changed to improve the stability of data storage. 
Data storage is still enabled under the features of 21 CFR Part 11. The way that MVSS analyzes data, and generates reports 
has not changed in any way.

•	 The new repository format allows the database to be viewed, but the files contained within it cannot be used or viewed 
outside of MVSS software. The only way to export the data is from within MVSS using the export function, and this 
action triggers an audit trail.

•	 The repository is created when the system is initially installed.

•	 Software updates keep the repository intact, however, this format of the repository in v3.1 is not backward compatible 
with v3.0 or earlier, unless the project files are converted. Please see “Upgrading MVSS to Version 3.1 and Higher” on 
page 11 for upgrade instructions.

•	 To improve archiving and reduce file storage on the repository, multiple projects can be exported followed by project 
deletion, if this feature is enabled. MVSS-compliant files can only be viewed when they are in the data repository.

In addition to the repository, other methods are employed to protect MVSS files: 

•	 CRC tags are calculated and verified on each file to detect modifications/corruption.

File Types and Naming
MVSS stores the results of an analysis in project files in the repository. Files on the repository can only be viewed from 
MVSS. Exported files in the proprietary binary format are named using the convention SampleName_ID. data, where 
SampleName is the name given when starting a sample analysis, and ID is defined in the notes below. The default naming 
convention and directory structure are shown below for projects exported in standard (human-readable) format. The 
following restrictions apply to file naming:

•	 Do not add unusual characters or symbols when naming files or it may prevent their analysis.

•	 Do not include commas in the project name.

•	 Set the system to English for regional settings. 

•	 File names that are extremely lengthy (20 characters or more) may be difficult to import into MVSS or MVAS.

SampleName_ID

SummaryFile<Run#> (CSV)

ImageFolder<Run#> (Images, JPG)

ParticleData (Reports, PDF)
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Notes: 

1.	 ID is a system-generated field based on the instrument type, serial number, and date/time the project was last modified 
in MVSS.

2.	 <Run#> refers to the Consecutive Run option in Method. If Consecutive Runs = 1 (the default), the <Run#> field is 
omitted from the name.

3.	 Native file formats are proprietary.

Audit Trail
The following specifications apply to the audit trail:

1.	 Unique ID codes identify all files (based on system, date, time, and number).

2.	 Unique system ID numbers are tracked.

3.	 Audit trail can be copied and archived.

4.	 All entries include the date, time, user ID, user full name, type of entry, old value, and new value.

5.	 A copy of the audit trail is provided with archived projects.

6.	 Periodic archival of the audit trail is performed.

7.	 Permission control is enabled to review, filter, copy, and export the audit trail.

8.	 The audit trail records actions completed on the audit trail.

9.	 Creation, deletion, or modification of a method is not allowed.

10.	The Audit Trail is read-only to all users.

11.	 The Audit Trail cannot be disabled.

The actions that will be tracked in the audit trail are outlined below.

File Type or Function Action

Raw files Creation, Archival

Converted files Copy (creation of converted file & export 
- summary, selective image, report, audit trail, etc.

Report generation Creation

Audit trail Archival, Copy (creation of converted file & export)

Methods Creation

User accounts Creation, Deletion, Modification, Login, Logout, Lockouts, Resets, Password changes
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Copying Regulated Data
Copies of regulated data can be made with certain restrictions and under the following conditions. Note that copies can 
be made in a secure compliant binary format, or an unsecured human-readable format that can be manipulated once 
exported from MVSS.

1.	 File format for binary data is proprietary to ProteinSimple.

2.	 Viewing binary files requires ProteinSimple MVSS.

3.	 Multiple copies of files can be made.

4.	 The audit trail records file copy activity.

5.	 Copied files in human-readable format are available in the following formats:

a.	 Tabular – CSV

b.	 Images – JPG

c.	 Reports – PDF

Multiple Reports
MVSS can generate multiple reports from the same regulated data set. The reports are in binary format and controlled by 
the system unless they have been exported in human-readable form by an auditor. 

1.	 Report Generation is defined in the Method.

2.	 New reports on the same data set can only be created using a “Report Only” Method.

3.	 Reports are controlled unless copied and exported in human-readable form.
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This chapter describes the menus and features of MVSS which are accessible from the top command bar of the Main 
Menu. 

Main Menu

File Menu

Export Single or Multiple Projects
The Export menu option exports Projects, Audit Trail, or Log files from the Repository. Use the Export feature to archive 
results and free up space on the Repository drive. In MVSS versions 3.1 and higher, single or multiple project files can be 
exported in either a proprietary binary format (DATA file) for archiving, or in a human-readable format (CSV, PDF, and JPG 
files) suitable for importing into MVAS. 
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Optionally, the projects can be deleted from the Repository after exporting in the native binary format mode. Single or 
multiple projects can be selected for export, or the entire Repository can be exported using the Export Entire Repository 
button. 

 

Import
The Import menu option imports previously-exported Projects, Audit Trails, or Log files into the Repository. Multiple files 
can be imported by holding down control or shift when selecting the files in the File Import dialog box. Import of multiple 
projects is supported in MVSS version 4.0 and higher.

I M P O R T P R O J E C T M E N U I M P O R T M E T H O D M E N U

Exit MVSS 
Exit MVSS closes the MVSS software.
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View Menu

View Report
Use View Report to view and print reports from previous analyses. 

Step 1 – Browse to select DATA File

Step 2 – Select Run

Step 3 – Select Report

Step 4 – Select View Report

Select to copy data for MVAS Select to view or print raw data file

Use Copy Run Data to copy MVSS files outside the secure repository. These CSV and associated image files can then 
be imported into MFI View Analysis Suite (MVAS). MVAS is a software application which complements MVSS. MVAS is 
specifically designed for image-based particle analysis and investigation of filters for particle characterization. MVAS 
filters can be recreated in MVSS 4.0 and higher for application to a large group of samples. Advanced reporting, data 
manipulation, and a real-time filter toolbox are some of the MVAS features. Contact ProteinSimple for more information.

Use the View Summary Table to view and print the raw data (particle size and morphology measurements) from the 
report.
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View Image
Use View Image to view image frames from previous analyses. 

Step 1 – Browse to select DATA File

Step 2 – Select Run

Step 3 – Select Image

Step 4 – Select View Report

Select to copy data for MVAS Select to view or print raw data file

View Method
Use View Method to view and print a Method Summary. Select a Method from the list and click Open to generate the 
Method Summary report. View “Report - Method Summary” on page 62 for an example. 

View Audit Trail
Use View Audit Trail to view and print the Audit Trail. The Audit Trail logs all system activity with a date/time stamp and 
other pertinent information. 
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View Log File
Use View Log File to view and print the Log Files for Flow Cell Focus, Flow Cell Integrity Check, and Calibration. 

LO G F I L E - F LOW C E L L F O C U S

LO G F I L E - F LOW C E L L I N T E G R I T Y C H E C K

The Calibration log file contains the results from the Optimize Illumination procedure. 

LO G F I L E - CA L I B R AT I O N

System Configuration Menu
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Hardware Settings

Use Hardware Settings to select the whether you are running a MFI 5100 or MFI 5200 instrument, enter the Serial 
Number, and the Electrical Module COM port. The Pump COM port and Prime speed are also entered here. The Repository 
capacity and available space are displayed.

NOTE: During the initial set, the Pump Control COM Port should be set to -250 and the prime speed should be set to 
6 mL/min. After this is set, reboot MVSS. The Pump Control COM Port will be greyed out after the reboot. 

To determine the correct COM port for the pump, exit to Windows®, and select Start>Control Panel>System>Hardware. 
Click on the Device Manager tab and select Ports. Use the COM port shown for the USB device.

IMPORTANT 
Whenever the COM port values are entered or changed, exit and re-launch MVSS before continuing. 
 
The system stage should not be homed by a user unless requested by ProteinSimple Service. 

The pump’s prime speed is determined when the pump is calibrated. Please refer to the instrument hardware manual for 
pump calibration instructions. 

MFI 5000 Series: The MFI 5000 Instrument does not require a Pump COM port to be specified. There is additionally a 
Home button used to home the stage when the instrument is first installed. 

27

Chapter 4: MFI View System Software (MVSS)  //  System Configuration Menu

MVSS User Guide



IMPORTANT 
The system should not be homed by a user unless requested by ProteinSimple Service. 

User Groups
The User Groups Menu is shown below. 

The Add User Group menu is shown below. 

A User Group is a profile for a group of users with equivalent permissions. Add, delete, or edit User Groups from this 
menu. The available permissions for User Groups are shown in the Add User Group menu above. Select the User Group 
type (Admin, User, or Viewer), enter a User Group name, and select the User Group permissions using the checkboxes.

User Accounts
The User Accounts Menu is shown below. 
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Once user permissions are changed, you can confirm that the software has updated them by viewing the User Account 
Menu.

A User is defined as a unique entity (i.e. Operator). Add or edit Users from this menu. Users can only be disabled and 
cannot be deleted.

Users must be part of a User Group. The Account Status can be active, inactive, or disabled. Accounts that are unused 
before the password expiry period automatically become inactive and the password must be reset by the User at the next 
login. User accounts that are disabled by the Administrator cannot log in. All fields are mandatory except Extension. The 
Administrator or other qualified User can reset a User password from this menu.

User Names and Passwords
User names and passwords are case-sensitive. User names are from 6 to 20 characters long and can contain characters 
and/or numbers. Passwords are from 6 to 20 characters long and must contain at least one character and one number. 

The administrator user name is Admin. The default password for the administrator and all Users is Password1. The default 
password must be changed at the first login. See the previous section for resetting passwords.
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System Operation

The System Operation Menu allows users to create a new method using the Create Method. To perform sample 
acquisition using a method or to create a report-only method, choose Analyze a Sample. Analyze Multiple Samples 
enables particle classification of multiple samples. In addition, users can select System Flush/Preview to ensure the flow 
cell is clean before a sample run. Selecting Stirrer Control allows the manual stirrer speed settings to be modified.

Create Method

An MVSS Method defines all the necessary parameters, sequence of operation, and report formats for an analysis.
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The Create Method wizard guides users through the process. Once a Method is created it cannot be revised or deleted. 
An existing Method can be used as a template to create a new Method which can then be saved with a new Method name. 

Create Method – Profile

The following parameters are entered in the Method Profile screen:

•	 Method Name: A unique name must be entered.

•	 Location: Accept the default or provide a location for the data in the Repository drive.

•	 Method Type: Select method type. See below for additional information. 

•	 Set Point: Select the instrument’s Set Point. Set Point refers to the flow cell used by the specific system. The MFI 5200 
uses SP3, while the MFI 5100 uses SP1. 

•	 Run Termination: Refer to “Run Termination Options” on page 32 for a description of these parameters.

•	 Edge Particle Rejection: Discarding edge particles can be used to focus on specific aspects in particle experiments. 
The raw data for the sample run will still capture edge particles, so this selection just applies to the method of analysis. 
Select edge particle rejection when accurate particle sizing is essential. Do not select it when particle count or 
concentration accuracy is needed.

•	 Fill Particles: Fill particles ensure that the interior of the particle is well-defined. Check to fill hollow particles. Checked 
is the default and is recommended in all cases.

•	 Consecutive Runs: Enter the desired number of consecutive runs (default = 1). Consecutive runs permit a large sample 
volume to be analyzed continuously and equally divided into smaller reports.
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Create Method – Method Types

There are three options for Method Type.

•	 Sample Analysis and Report (default): This Method type includes both sample analysis and auto-generation of a 
report at the conclusion of the run.

•	 Report: This Method type creates a Report based on a previous (stored) sample analysis. It is used to re-process the 
raw data from a previous sample analysis with different conditions (e.g. morphological filters). See “Analyze a Sample” 
on page 38 for a description of how to retrieve the previous run.

•	 Sample Analysis: This Method type is used to perform a sample analysis without generating a report at the end of the 
run.

Run Termination Options

Once the Purge Volume has been determined, the Run Termination type can be selected. For the MFI in manual mode, five 
options are available, as shown below. For the Bot1 system, the only option is Sample Dispensed. See “Purge Volume” on 
page 71 for the Purge Volume definition.

Stirrer Control (MFI 5000 Series)
The MFI 5000 Series instruments come with an integrated stirrer. The user can set the stirrer RPM and stir direction in this 
dialog box.
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Sample Dispensed (Default)

With Run Termination set to Sample Dispensed, the pump will dispense an exact volume of fluid (including the Purge 
Volume) and then stop. Concerning Protocol Development, the Sample Dispensed is deterministic and the normal mode of 
operation. To determine the amount of the pumped fluid that will be analyzed, use the following formula:

Sample Analyzed = (Sample Dispensed – Purge Volume) * Sampling Efficiency

MVSS displays this value in the Run Termination dialog box as Analyzed Volume (mL, approximate). Sample Dispensed is 
the default option for the termination of Bot 1 sample run.

Sample Analyzed

With Run Termination set to Sample Analyzed, the pump will operate until enough volume has been dispensed to analyze 
the desired volume. The Purge Volume and sampling efficiency are incremental to the Sample Analyzed. To determine the 
minimum sample volume required, use the following formula:

33

Chapter 4: MFI View System Software (MVSS)  //  System Operation

MVSS User Guide



Minimum Sample Volume = (Sample Analyzed – Sampling Efficiency) + Purge Volume

MVSS displays this value in the Run Termination dialog box as Minimum Sample Volume (mL, approximate). Note that 
Sampling Efficiency may vary slightly from the nominal value.

Elapsed Time

With Run Termination set to Elapsed Time, the pump will operate for the time entered. To determine the minimum sample 
volume required, use the following formula:

Minimum Sample Volume = Elapsed Time * Pump Rate

MVSS displays this value in the Run Termination dialog box as Minimum Sample Volume (mL, approximate). 

Image Capture

With Run Termination set to Image Capture, the pump will operate until the entered quantity of frames is captured 
(maximum value is 20,000). Frame capture will begin after the Purge Volume (if any). To determine the minimum sample 
volume required, use the following formula:

Minimum Sample Required ÷ (Image Quantity = Frame Rate ÷ 60 * Pump Rate) + Purge Volume

MVSS displays this value in the Run Termination dialog box as Minimum Sample Required (mL, approximate). 

Manual

With Run Termination set to Manual, the pump will operate until:
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•	 The user stops the pump using the on-screen controls, or

•	 The maximum number of frames (20,000) is reached, or

•	 The maximum number of particles (1 million) is reached.

Create Method – Morphological Filters

Morphological filters can be added by checking the parameter and then adding the conditions, values, and operator. 

Create Method – Image Capture
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Specify the Image Capture criteria. If an exact number of images is specified MVSS will display the corresponding 
storage requirements. Note that if Store All Images is specified MVSS has the option to Discard Empty Frames (default, 
recommended).

NOTE: In order to use MVAS for further analysis of results, images must be stored.

Create Method – Report Format

Users can configure their report format at the time of method creation. A report-only method can also be created to view 
the results of a sample that has been already analyzed as described in “Create Method – Method Types” on page 32. 
Refer to “Chapter 5” for additional information on Reports.

Select the Chart Type (Histogram, Scatter Plot, or Time Resolved Mode). Select the x and y axes parameters and adjust 
the chart scales as required. If no values are entered MVSS will autoscale the charts.

Select Include Raw Data to append raw data from the chart in the report (maximum 100 pages).

Select Include Method Summary to include the Method Summary in the report.
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Create Method – Particle Statistics and Images

Check Include Particle Statistics and Images to add statistics and cropped particle images based on size (ECD) and an 
optional, user-selected morphological parameter to the report. For each parameter, there are a total of 18 ranges or bins 
that can be defined. Each range is individually selectable and is defined with a minimum and maximum value. To create a 
cumulative range, set the maximum to the highest possible value.

For every selected range, cropped particle images can be included in the report (maximum 50 per range). The default 
value is 10. It is not recommended to include cropped images for particles 5 µm. Enter zero (0) if no particle images are 
desired.
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Create Method – Save Method

Prior to saving, the Method can be viewed. Use the Back button to edit as required. Once Method is complete select Save 
Method. Once saved, Methods cannot be revised or deleted.

Analyze a Sample

For convenience, the Sample Analysis menu is a step-by-step procedure.
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This procedure allows for sample acquisition or use of a report-only method following sample acquisition. To analyze 
particle sub-populations for a group of samples, use the Analyze Multiple Samples feature in the System Operations menu. 
For more details see “Analyzing Multiple Samples” on page 40.

•	 Step 1: Select a Method from the drop-down menu. A summary of the selected Method will be displayed for reference. 
Select Method Details to view the entire Method.

•	 Step 2: Verify the hardware settings (for MFI 5100 or MFI 5200) and Flow Cell Focus Position are correct.

•	 Step 3: Prime/Flush the system as required. Ensure a suitable volume of Flush fluid is loaded before starting the Pump 
by selecting the Prime button on the menu.

•	 Step 4: The Optimize Illumination step is mandatory and should always be performed using a particle-free version 
of the sample fluid. Optimize Illumination ensures that the particles in the solution can be distinguished from the 
surrounding solution. 

•	 Step 5: Load the sample and press Start Analysis to begin the analysis. If the Method type is Report Only select Load 
Sample and browse to the correct sample data to generate the Report.

The Run Status dialog box is shown below.

While a sample is being analyzed the monitor will display the camera output and a Run Status dialog box. Toggle between 
Binary and Grey Scale images using the check box. The run can be terminated by selecting Stop Run. Run statistics are 
provided while the run is underway.

If a Report is specified, it will automatically be displayed at the end of the run. Refer to “Chapter 5” for a description of the 
Report.
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Analyzing Multiple Samples
The ability to analyze multiple samples makes it possible to create sub-population filters for a batch of sample runs 
instantaneously. 

MFI has the following complementary software products for particle analysis:

•	 MFI View System Software (MVSS)

•	 MFI View Analysis Software (MVAS, discontinued) or MFI Image Analysis

MVSS operates the instrument and acquires particle data in a structured way, offering size, count, concentration, and 
basic analysis with full 21 CFR Part 11 security. MVAS and Image Analysis are optional packages for sample analysis that let 
you develop particle classification filters based on visual inspection of particle images for your individual samples. Both 
analysis packages can utilize standard exports for sample projects. Image Analysis can be run on its own on a separate 
computer, or be installed on the MFI computer with MVSS for a fully 21 CFR Part 11-compliant workflow. Additionally, 
when Image Analysis is run on the same computer as MVSS, the filters are shared between the software applications, 
eliminating the need for filter export/import.

A new workflow for particle characterization shown below now simplifies the process by combining the image 
visualization of MVAS/Image Analysis with the high throughput benefits of MVSS software.

1.  Develop a filter method in 
     MVAS/MFI Image Analysis

2. Apply HT analysis in MVSS

Export 
samples into 
MVAS/Image 
Analysis

Create  
filters

Apply 
filters in 
MVSS

View 
analysis 
results

To access multi-sample analysis, select System Operation > Analyze Multiple Samples: 

You can analyze up to 90 samples at once in the Multi-sample Analysis window shown below. 

1.	 Create one or more particle classification filters.

2.	 Apply them to a group of sample runs imported for analysis.
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3.	 View the results all at once. 

4.	 Export data in a histogram-friendly format for record-keeping or further analysis. Data can also be exported in PDF 
format.

5.	 Filters created in Multi-Sample Analysis can be imported or exported.

To instantly classify particles:

3. View instant results

4. Export CSV data

2. Choose projects

1. Select filters
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How to Import Data Files

MVSS provides the flexibility to analyze both compliant and non-compliant data together, allowing a variety of sample 
comparisons. You can import MVSS files from the data repository or CSV files from MVAS or Image Analysis as shown 
below. 

I M P O R T I N G C SV F I L E S F R O M M VA S:

•	 To import CSV files for multi-sample analysis in MVAS, select Import at the bottom of the window. 

•	 To import MVSS data in MVAS, select project data in the Projects area at the top left of the window.

I M P O R T I N G C SV F I L E S F R O M I M AG E A N A LYS I S

•	 To import CSV files for multi-sample analysis or MVSS data in Image Analysis, select File > Open.
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How to Export CSV Data for Histograms

In MVSS 4.0 and higher, analysis results are exported as CSV files in a tabular format. To allow multiple options for later 
evaluation or record-keeping, you can specify the format of the data as shown below. There can be different histogram 
settings for different morphologic parameters.

.

How to Create or Edit Filters

MVSS 4.0 and higher uses a trunk and branch type of structure for filter development. The trunk is the entire particle 
population “universe” (called All) and the sub-populations are branches of this trunk.

There are two ways to create filters for particle sub-population analysis:

•	 Recreate existing MVAS or Image Analysis filters: use MVSS to apply current filters in a high throughput way.

•	 Develop more complex filters in MVSS 4.0: MVSS 4.0 uses more combinations and in some cases, this classification 
can be more accurate than MVAS or Image Analysis.

The examples that follow in the next sections show how to create a variety of new filters with MVSS that either duplicate 
existing MVAS or Image Analysis filters or create ones that MVAS and Image Analysis cannot. MVSS 4.0 has greater 
flexibility than MVAS and as a result, it can duplicate an MVAS filter or it can create more sophisticated filters ideal for 
very complex particle mixtures. MVSS 4.0 also includes several pre-set filters such as USP 787 and the S-factor filter to 
perform common filters used for biopharmaceutical testing.
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Replicate MVAS and Image Analysis Filters that Remove Sampling Artifacts

A key benefit of MVSS is that it can replicate popular MVAS and Image Analysis filters that ensure data quality, such as 
removing stuck particles and slow-moving particles. These filters apply to the main sample “universe” (called All). After 
filters have been applied to All, other filters can be created for subsequent populations, for example, the USP 787 filter 
shown be;pw:

Create a Filter with a Sub-population and its Inverse

Filters are used to classify particles into different groups based on their size and morphologic properties. When you create 
a filter, you have the sub-population itself. The inverse of that filter can also be created, which forms another separate 
sub-population. In the example diagram below, a starting group of particles is separated by Filter A, and the opposite of 
this filter is the A Complement. The Complement can also be called the ‘logical NOT’ of the filter. 

The format that MVAS and Image Analysis use to create a filter requires a sub-population with its inverse, as just 
described. However, with MVSS, you have the option to choose that format or take a completely different approach with a 
merging filter, as discussed in the next section. 
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Creating a Merging Filter

You can merge two sub-population using OR in a filter. As an example of how to do this, we’ll use Big and Small which are 
sub-populations generated from All (the entire particle population). To create a merging filter use this example: 

1.	 Create two separate filters, Big and Small.

2.	 Change the Test column to OR. 

3.	 Select the filters to form a union. Big OR Small is the merging filter that results:

Create More Complex Filters

MVSS has the ability to create more complex filters and also includes a popular filter called the S-Factor which can be 
used to evaluate particle groups such as silicone oil (Oil) from potentially protein-like particles (Non-Oil). The effectiveness 
of this filter should be evaluated for a particular sample type.

System Flush/Preview 

Refer to “Flush” on page 69 for a description of System Flush/Preview.
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System Maintenance
The System Maintenance Menu is shown below. 

Flow Cell Integrity Check

Flow Cell Integrity Check verifies the cleanliness of the flow cell. A wizard guides users through this routine. The 
procedure will return a Pass/Fail indication when complete. Flow cell lifetime is generally 100 runs on the instrument. If 
the Flow Cell Integrity Check continually fails, evaluate the flow cell lining to determine whether the flow cell should be 
replaced. The Flow Cell Integrity Check is different from the flow cell focus, which is used to focus a new flow cell.
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Flow Cell Focus

Prior to use, installation of a new flow cell on an instrument requires the Flow Cell Focus procedure to be performed. This 
is a wizard-based procedure that takes approximately 10 minutes for an experienced user.

NOTE: Flow Cell Focus values are specific to individual MFI 5000 Series instruments.

Flow Cell Focus can be performed as often as desired. Flow Cell Focus must be performed at initial installation, anytime 
the instrument is moved, or if there is any reason to believe that the system is not aligned properly.

Flow Cell Focus (MFI 5000 Series)

Have the following materials on hand:

•	 10 mL syringe barrels (2)

•	 Polystyrene bead (10 µm) standards for size, including original container

•	 Particle free water (30 mL)

Flow Cell Focus (Bot1)

Have the following materials on hand.

•	 50 mL vials

•	 Polystyrene bead (10 µm) standards including original container

•	 Particle-free water (20 mL)
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Fill one vial with 10 mL of water, and one vial containing 10 mL of 10-micron beads at a concentration of 
30,000+ particles/mL. 

For the MFI 5000 Series with the Bot1 Autosampler a direct vial feed configuration can be used. Connect the flow cell inlet 
to the water vial using tubing (4006-016-001) as shown below. 

For stand-alone MFI 5000 Series instruments (without Bot1), leave the flow cell tubing attached to the inlet port. Attach 
a 10 mL syringe barrel to the inlet port. Follow the steps in the wizard, using the vials of water and 10 μm particle sizing 
beads where required.

D I R E C T V I A L F E E D C O N F I G U R AT I O N F O R M F I  50 0 0 S E R I E S I N S T R U M E N T S W I T H T H E B OT 1 
AU TO S A M P L E R

Flow Cell Focus Procedure	

Perform the Flow Cell Focus for each new flow cell.

1.	 Write the focus number down on the flow cell insert.

2.	 From the main software menu, select System Maintenance > Flow Cell Focus. 
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3.	 Enter the requested information for bead size standards, then click Next:

4.	 Enter the flow cell serial number, then click Next:
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5.	 Set up the instrument for the bead solution:

•	 For stand-alone MFI 5000 Series instruments (without Bot1): Fill a syringe barrel with 10 mL of particle-free water.

•	 For MFI 5000 Series instruments with the Bot1 Autosampler: Insert the free end of the tubing connected to the flow 
cell into the vial of particle-free water.

Click the first OK button to continue:

6.	 Start the Optimize Illumination by clicking the second OK button. When the Optimize Illumination is complete, click 
Next:
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7.	 Mix the bead solution: 

•	 With syringe barrel: Fill with 10 mL of particle-free water and 3 to 8 drops of 10 µm particle sizing beads. Pipette up 
and down to mix.

•	 With Bot1: Insert the free end of the tubing connected to the flow cell into a vial of water with the beads. See the 
“direct vial feed configuration” on page 48. 

Click the first OK button.

8.	 Use the Back and Forward buttons to move the coarse focus position until the beads are focused by the eye. You’ll 
observe the beads going from blurry to focused on the screen:

9.	 Click the second OK button to have the instrument count ~2500 beads and display the average measured ECD (size). If 
the mean ECD is close to the actual size, click Next to perform the Focus Sweep
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Pump Calibration (MFI 5000 Series)

The Pump Calibration is a wizard-based routine for calibrating the integrated pump in the MFI 5000 Series instruments. 
The routine consists of a four-minute calibration step and a 15-minute verification step. 

The Pump Calibration procedure for the MFI Series without a Bot1 autosampler follows in the next section. For the Pump 
Calibration procedure with the MFI 5000 Series with a Bot1 autosampler, see “Pump Calibration for MFI 5000 Series With 
Bot1” on page 55.

Pump Calibration (With Syringe Barrel) for MFI 5000 Series Without Bot1

Have the following materials on hand:

•	 Particle-free water

•	 Empty containers for waste (pre-weigh)

•	 10 mL syringe barrel

•	 Scale

Pump Calibration Procedure	

1.	 Fill the syringe barrel with at least 10 mL of particle-free water.

52

Chapter 4: MFI View System Software (MVSS)  //  System Maintenance

MVSS User Guide



2.	 Ensure there is no air in the system by flushing the syringe barrel with particle-free water. To do this, select System 
Operation > System/Flush Preview from the main menu:

3.	 Pre-weigh one of the vials and then place the end of the waste tubing in that vial.

4.	 From the main menu, select System Maintenance > Pump Calibration. 

5.	 Follow the Pump Calibration Wizard:

For the calibration, you will need at least two pre-weighed vials to measure liquid dispensed through the waste tubing. 
Near the end of the calibration, make sure to record the Measured Volume outside of MVSS as it is needed for later 
steps.

53

Chapter 4: MFI View System Software (MVSS)  //  System Maintenance

MVSS User Guide



6.	 Determine the weight of the dispensed water and enter the weight value. Click Update Calibration, then click Next: 

7.	 Transfer the waste tubing to a new empty pre-weighed container.

8.	 Click Start Verification to continue the calibration.

9.	 Measure the amount of volume dispensed and enter the value (be sure to convert to mL), then click Submit. Verify 
pump calibration as instructed and click Start Verification (requires 15 minutes).
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10.	The software will display a Passed or Failed result. 

Pump Calibration for MFI 5000 Series With Bot1

This step ensures that the volume in the Bot1 sample port remains constant. If the dispense rate and the pump flow rate 
are out of sync, then two scenarios may occur: 

•	 If the Bot1 dispensing rate is too slow, the sample port may run dry after an operation that uses the MFI pump (optimize 
illumination, analysis, baseline, etc.). This can introduce air pockets and/or introduce bubbles in the next volume of 
liquid pipetted into the sample port.

•	 If the Bot1 dispensing rate is too fast, the sample port liquid level will increase over time after several liquid flushes. 
This can increase the dilution effect, and thus decrease the effective amount of sample analyzed.

For these reasons, the Bot1 dispensing rate and MFI pump must be properly calibrated and synced to minimize the effects 
described above.

Have the following materials on hand:

•	 Three vials which can hold at least 10 mL of liquid each (15 mL Falcon tubes work best)

•	 Particle-free water or Milli-Q® water

•	 Long tubing (P/N 4006-016-001). This is shipped with the instrument and is also used for Flow Cell Focusing.
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Pump Calibration Procedure

Step 1: Calibrate MFI Pump	

1.	 Select System Operation > System/Flush Preview from the main menu: 

In the new window, click Prime to flush out all the liquid from the system and fill it with air. 

2.	 Once all liquid is removed from the system and tubing, connect the long piece of tubing to the flow cell inlet as shown 
below. Place the other end of the tubing in a vial filled with 10 mL of water. 

3.	 For the calibration, you will need at least two pre-weighed vials to measure liquid volume dispensed through the waste 
tubing. Pre-weigh one of the vials and then place the end of the waste tubing in that vial.

4.	 From the main menu, select System Maintenance > Pump Calibration: 
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Follow the instructions in the Pump Calibration Wizard. Near the end of the calibration, make sure to record the 
Measured Volume outside of MVSS as you will need this number in later steps.

Step 2: Determine the Volume Correction Factor	

5.	 Use the following equation to determine the dispense volume (Measured Volume here is the same as the Measured 
Volume in the prior step):

Pump Dispense Volume (µL) = 900 µL x (Measured Volume/2.55)

6.	 Calculate the difference between the Bot1 pipette dispense volume and the Pump Dispense Volume calculated above:

Volume Difference (µL) = (Pump Dispense Volume) – 887µL

 NOTE: The Bot1 pipette dispense volume is constant at 887 µL (factory average).

A positive value indicates the system will be short by X µL of fluid for every flushing operation (the sample port will 
empty overtime during a run). A negative value indicates the system will have excess fluid by X µL for every flushing 
operation (sample port with fill up over time).

7.	 Convert the Volume Difference from µL to mL (i.e. 17 µL = 0.017 mL).

8.	 From the main menu, select System Maintenance > Bot1 Configuration. In the Calibration box, adjust the Volume 
Correction Factor multiplier to compensate for the Volume Difference calculated in the prior step (in mL). The default 
value is 1. The value to input will be 1.000 plus the volume difference in mL. 

For example, if the calculated Volume Difference is -17 µL, then the Volume Correction Factor is calculated as  
1 + (-0.017) = 0.983.

See the table below for compensation value examples. 

Volume Difference (μL) Volume Difference (mL) Volume Correction Factor

-20 -0.020 0.980

-15 -0.015 0.985

-10 -0.010 0.990

-5 -0.005 0.995

0 0.000 1.000

5 0.005 1.005

10 0.010 1.010

15 0.015 1.015

20 0.020 1.020

57

Chapter 4: MFI View System Software (MVSS)  //  System Maintenance

MVSS User Guide



9.	 Enter values in the Calibration box.

10.	Accept the changes and close the window. MVSS will prompt you to exit and restart the software.

Step 3: Verify Bot1 Volume Correction Factor

11.	 Start the MVSS software.

12.	Reconnect the tubing from the bottom of the Bot1 sample port to the flow cell inlet.

13.	Fill one Bot1 reservoir tray with at least 100 mL of filtered water. Place the reservoir in position 5 of the Bot1 tray. Make 
sure pipette tips are available and the tip discard bin is empty.
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14.	From the main menu, select System Operation > Batch Management and load the 9Flush1Analysis batch. This batch 
consists of one flush of 0.9 mL water at 6 mL/min, then nine flushes of 0.9 mL water at 1 mL/min, and finishes with an 
analysis of 0.7 mL water with a 0.0 mL purge. 

NOTE: Make sure the appropriate method for the analysis operation has been created before running the batch.

15.	Execute the batch. Note the volume of liquid in the sample port after the first flush. Monitor the volume in the sample 
port after each subsequent flush and verify that the volume is relatively constant. Also, monitor the flushing operations 
on-screen and look for the presence of micro air bubbles or large air pockets. 

If air bubbles or air pockets are present, this indicates that the sample port fluid level is decreasing with each flush and 
the calibration needs to be adjusted. Fine-tune the calibration by adjusting the Volume Correction Factor in the Bot1 
Configuration window per the prior steps. Inputting a larger number will increase the volume in the sample port. If the 
volume in the sample port increases during the batch, then the Volume Correction Factor needs to be decreased. The 
amount of change in volume will dictate how to change the correction factor: a large difference in volume between the 
first and last flush suggests changing the factor by 0.01 units, while a small difference in volume suggests changing the 
factor by 0.001 units.

16.	Repeat the steps in “Step 2: Determine the Volume Correction Factor” and “Step 3: Verify Bot1 Volume Correction 
Factor” until the volume in the Bot1 sample port remains constant throughout the 9Flush1Analysis batch run. The 
volume is constant when there is no buildup of liquid.

Help
Use the Help menu to view the About MFI View System Software screen containing the MVSS Version number. The 
License Agreement is also accessible from the Help menu.
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Reports
MVSS reports are automatically created at the conclusion of a Sample Analysis. Reports consist of five sections. Please 
refer to the annotated figures below for a description of each section.

All pages are individually numbered and identified.

Section # Title Description Optional?

1 Title Page Sample Identification, ECD Summary Statistics, and Range 
Statistics (if selected) No

2 Chart Sample ID and Chart (Histogram, Scatter Plot, or Trend) No

3 Method Summary Summary of the Method Used to Analyze the Sample Yes

4 Chart Data Chart raw data (max. 100 pages) Yes

5 Cropped Particle Images

Cropped particle images for the ranges/bins specified in the 
Particle Statistics section of the Method. Each range/bin is on 
a separate page. Up to 50 cropped particle images can be 
selected for each range/bin

Yes

R E P O R T - T I T L E PAG E

Sample Analysis Summary

Size (ECD) Statistics

Size (ECD) Ranges/Bins

Optional Parameter Ranges/Bins
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R E P O R T - H I S TO G R A M C H A R T

R E P O R T - M E T H O D S U M M A RY

Method ID

Image Storage

Report Type and Axes

Report Options

Size (ECD) Ranges/Bins

Optional Parameter  
Ranges/Bins

MFI Configuration

Run Configuration

Morphological Filters  
(if selected)
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R E P O R T - C H A R T DATA

R E P O R T - C R O P P E D PA R T I C L E I M AG E S

Parameter ID and Range #, Min-Max

Size Scale (for reference)

Cropped Particle Images  
(default = 10, maximum = 50)

Note: Particle ID = F#. P#  
(Frame #, Particle #)
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Exporting Reports
Reports for one or multiple projects can be exported. To do this, go to File Menu > Export > Reports.

Use Ctrl-Click to select multiple reports to export, then click Export. You can also select Export Entire Repository to 
export reports for all projects in the repository.
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Archiving Data
MVSS can automatically archive data from the repository to a destination of your choice (i.e. network drive, external hard 
drive). Data will be automatically archived after each sample (if running in manual mode) or batch. To do this, go to System 
Configuration > Data Archiving.

NOTE: Data that already exists in the repository prior to enabling archiving in MVSS 5.1.2 will still need to be 
manually moved to the archive location.

Checking the Enabled box will turn on automatic archiving. Click on Browse to select a location to archive the data. If the 
Auto delete oldest projects box is checked, MVSS will automatically delete the oldest data from the repository once free 
local hard drive space is less than 20%.
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Protocol Development
Prior to analyzing a sample, an operating protocol should be developed. The operating protocol includes the steps for 
flushing the system, particle baseline, and analysis. For the MFI 5100 instrument with the Bot1 or MFI 5200 instruments 
with the Bot1, the batch is the operating protocol which includes all of these steps together. The operating protocol can be 
simple or complex depending on the specific requirements of the sample and the objectives of the analysis. MFI 5100 and 
MFI 5100 systems have the flexibility to accommodate a wide range of operating protocols and, once a protocol has been 
developed, the Method Analysis ensures accuracy and repeatability are maintained. This section provides background 
information and guidance on developing MFI 5100 or MFI 5200 sample analysis protocols.

It is not possible to describe all the potential configurations and protocols for different sample types, flush fluids, sample 
volumes, etc. Application and Technical Notes are available on many protocols not described here. For specific sample 
requirements, please contact ProteinSimple Technical Support.

Overview
The objectives in developing an MFI operating protocol are:

1.	 To ensure the system is clean prior to use (i.e. an acceptable baseline is achieved).

2.	 To eliminate cross-contamination between samples.

3.	 To minimize cycle time.

The Methods and Sample Analysis menus facilitate these objectives.

The MFI instrument operates in manual mode and draws sample fluid through the flow cell. The sample is introduced into 
the flow cell from an Inlet Port located directly above the flow cell. The Inlet Port accepts 1 or 5 mL pipette tips and 2, 10, 
and 20 mL syringe barrels. The Inlet Port is connected to the flow cell using disposable tubing. The MFI with Bot1 uses an 
automated pipettor with 1 mL conductive tips to introduce the sample into its larger Inlet Port.

As the fluid transits the flow cell measuring zone, images are taken of a fluid volume (this volume is fixed for each Set 
Point). Every image is analyzed for suspended particles and all particles are counted and measured for size and other 
morphological parameters. The timing of image capture has been selected for optimal sampling efficiency without frame 
overlap.

The important MFI parameters to produce accurate and repeatable results are Purge Volume and Termination Type. 
Purge Volume refers to the amount of fluid that will be pumped before particle measurement begins. Termination Type 
determines the condition for the pump to stop operating. Together, these two parameters are used to configure the 
instrument for sample analysis. There are several potential combinations and MFI has built-in tools to assist in choosing 
the correct combination based on user requirements. More information is provided later in this chapter. 
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Typical Operating Protocol
A typical operating protocol for a stand-alone MFI instrument or one with Bot1 is shown below.

Flush System

Repeat as 
Required

Repeat as 
Required

Perform Baseline

Analyze Sample

Flush System

Shutdown

This protocol is suitable when a series of similar samples will be analyzed at the same time. In this instance, similar refers 
to physical characteristics like transparency and viscosity.

Flush
System Flush/Preview is accessed from the MVSS System Operation tab for a stand-alone MFI system or one with Bot1. 

Flush a Flow Cell prior to, and between, analyzing a sample and at shut down. The camera output is displayed on the 
instrument monitor for visual verification of system cleanliness. A flush is normally performed at the pump’s PRIME speed. 

CAUTION 
If the Flow Cell edge is visible in Preview Mode (as a black bar at either the top or bottom of the 
screen), remove and re-insert the Flow Cell. Refer to “Troubleshooting” on page 95 if this condition 
persists.
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Fluid Introduction

MFI (Manual Only)
Fluids are introduced to the MFI from vessels mounted in the Inlet Port (the stainless steel coupler mounted on the 
armature directly above the Flow Cell). Any vessel with the appropriate geometry can be used. The Inlet Port accepts 1 
and 5 mL pipette tips and 2, 10, and 20 mL syringe barrels. Contact ProteinSimple for a list of compatible pipette tips. The 
syringe barrels may be equipped with a male luer fitting if desired. Other vessels equipped with a male luer adaptor can 
also be used. Contact ProteinSimple for assistance.

Pipettors must be variable, two-step models with separate tip ejection and blow-out.

The default state for introducing fluids assumes that the inlet port is “wet” (i.e. fluid is present in the flow cell, inlet 
tubing, and Inlet Port). This reduces the risk of bubble formation between samples. However, it also requires that the fluid 
remaining in the wetted components be purged at the start of a sample analysis. Purging is discussed in the following 
section.

The MFI instruments can be operated using different fluid vessel configurations which may offer advantages for specific 
sample types and volumes. Please contact ProteinSimple Customer Service for additional information.

MFI 5000 Series with Bot1 Autosampler
The MFI 5000 Series with the Bot1 uses an automated pipettor with 1 mL conductive tips to introduce the sample into its 
sample Inlet Port, directly on the Bot1 Autosampler deck. The Bot1 does not accept syringe barrels for fluid introduction in 
automated mode.

Baseline Runs
A Baseline Run is performed to verify and quantify system cleanliness. It should be performed prior to every set of sample 
analyses and on an as-required basis afterward. Always use particle-free flush fluids for baseline runs. 

After the baseline run finishes, review the particle concentration within the size range(s) of interest. If desired cleanliness 
is not achieved, re-perform the Baseline Run. If problems persist, refer to “Troubleshooting” on page 95. A Baseline can 
also consist of the average of multiple runs. 

NOTES: 
Sample preparation and transfer under a laminar flow hood is recommended to prevent contamination from airborne 
particulates and to achieve the cleanest baselines. 
 
If a particle appears “stuck” on display, the Flow Cell may have moved or become contaminated. Flush the system 
and repeat the Baseline Run.
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Purge Volume
When a sample vessel (pipette or syringe barrel) is connected to a wet Inlet Port, a portion of the sample will mix with the 
flush fluid. This mixed sample/flush fluid plus the flush fluid that was left in the fluid path must be purged before sample 
analysis can begin. The combined volume is referred to as the Purge Volume.

Purge volumes will vary depending on the nature of the flush and sample fluids. The default values were determined using 
particle-free water and polystyrene bead standards. For a 1 mL pipette tip, the default value is 0.2 mL. This is also the 
system default. For a syringe barrel without a stopcock, the default Purge Volume is 0.45 mL. For a syringe barrel with a 
stopcock, the default Purge Volume is 0.65 mL.

It is strongly recommended that Purge Volume be confirmed and measured for each flush fluid/sample combination. Purge 
Volume can be determined by experimenting with Purge Volume set to zero and using MFI’s Trend Chart (Time-Resolved 
Analysis mode). The objective is to measure the particle concentration from Time (0) until time x when the particle 
concentration becomes stable. At Time (x), the pure sample is in the Flow Cell and is therefore the time required for the 
Purge Volume to be removed. This is shown below. 

Note that the time scale is a fraction of a minute. Compute the Purge Volume by multiplying Time (x) by the Pump Speed 
for the Set Point. The nominal values for Pump Speeds are shown in the table below for each Set Point.

Set Point Purge Volume Formula

SP1 Time(x) * 0.22

SP2 Time(x) * 0.10

SP3 Time(x) * 0.17
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Schlieren Lines
If the flush and sample fluids have different physical properties, dark wavy Schlieren lines will be observed as the mixed 
fluid transits the Flow Cell. The Purge Volume must be large enough to ensure these Schlieren lines (i.e. the mixed fluid) 
are purged before particle analysis begins. 

A density-matched buffer should always be used between samples to avoid Schlieren lines. In the case of viscous 
samples, perform a Pump Calibration as described in “Pump Calibration (MFI 5000 Series)” on page 52 with the viscous 
liquid to ensure correct measurement. To determine the correct Purge Volume, follow the same procedure as described 
earlier in “Purge Volume” on page 71. An example of a Trend Chart showing Schlieren lines is shown below.
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Bot1 Autosampler
The Bot1 Autosampler is an optional module that can be attached to an MFI 5000 Series instrument. It consists of an 
automated pipette system with a removable tray that supports four, full-sized ANSI/SBS-compliant modules, one half-
size module, and one quarter-sized module. The automated pipette system can be configured through MVSS to dispense 
samples, flush/clean the system, and perform periodic automatic baselines. 

The Bot1 deck layout is shown below. The pipette tip rack and deep well plates can be in locations 3, 4, 5, and 6. 

Reusable
tip holder

Tip waste bin

Pipette tip 
rack holder

The presence of the Bot1 will be automatically detected by MVSS and will open up new menu options to allow the user 
to create and execute sequences of measurements known as batches, as well as perform routine maintenance on the 
instrument. These menu options are described in this chapter.

Bot1 Calibration
The Bot1 has a calibration routine to ensure positional accuracy of pipetting and accurate dispensing into the Bot1 sample 
inlet port. The x,y, and z position of the pipette unit is verified through the use of a reference calibration pin. The Bot1 
Calibration dialog can be found in the System Maintenance menu. The Bot1 should be calibrated weekly, or if the system 
has been bumped, moved, or found to be out of calibration. 

Bot1 Calibration for Positional Accuracy Only
To perform a calibration for positional accuracy only, use the following steps. To calibrate the system, see “Bot1 Sample 
Inlet Port Calibration” on page 75.

1.	 Select the Calibration Pin from the drop-down box.

2.	 Press Start Calibration. The system will warn that continuing will clear the existing calibration values. Click OK to 
proceed.
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3.	 The system will move close to the calibration pin. Using the directional controls shown below (left), move the pipette 
unit until it is just touching the top of the calibration pin as shown below (right), adjusting the Step Size to a smaller 
value as you approach the pin as needed. Take care to not crash into the pin. 

4.	 Press Set. The system will automatically re-initialize and then move back to the pin.

5.	 Verify that the pipette unit successfully moved back to the pin in the calibrated position. Small positional errors of less 
than ~0.2 mm are to be expected. 

6.	 If the calibration is not satisfactory, repeat the steps above. 

Bot1 Sample Inlet Port Calibration
The Bot1 pipette tip must be properly aligned with the left side of the inlet port to ensure correct fluid dispensing. When 
the pipette tip is not aligned properly with the inlet port on the Bot1, this can cause microbubbles or even overflow of liquid 
when pipetting. 

Correct Positioning of Pipette Tip Relative to Sample Inlet Port

The Bot1 is attached to the top of the MFI 5000 Series instrument via three alignment pins located on the top plate of the 
MFI 5000. However, there can be some variability in the x-y-z location of the sample inlet port concerning the Bot1. The 
sample inlet port position is configured during the Bot1 installation, but moving or bumping the instrument can cause some 
adjustment of the inlet port to be required. 
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The correct position of the pipette tip with respect to the sample Inlet Port is shown below. The tip should be located 
slightly to one side of the port, and below enough such that the tip is submerged into the fluid in the sample Inlet Port. If 
the tip is located above the fluid in the port, the dispensing operation will cause micro air bubbles to form in the liquid.

Inlet Port Calibration Procedure

Ensure that your fluidics is set up correctly with the MFI pump and volume dispense rate calibrated. Then perform the inlet 
port calibration using the following steps.

1.	 In the MVSS main menu, select System Operation > Batch Management. Create a batch operation with one flush 
of water at 0.9 mL at a rate of 6 mL/min. Place the pipette tips and reservoir buffer for flushing on the left-hand side 
(positions 3 and 5) of the Bot1 so that the inlet port is clearly visible.

2.	 Execute the batch. During the single flush, examine the pipette tip location in the sample port, and compare it to the 
figure below. If required, go to System Configuration > Bot1 Configuration and adjust the sample Inlet Port location. 
A more positive x- or y-value will shift the pipette tip left/down relative to the port. A more positive z-value will move 
the tip lower into the port. The pipette tip should be as low in the port as possible without touching the port.

3.	 Exit the menu and restart MVSS. Repeat steps 1 and 2 to fine-tune the port location as required until the pipette tip is 
located in the port as shown below.

52 mm (approx.)

Pipette Tip 
Location

75 mm
(approx.)

Sample Inlet Port

(0,0)

Y

X

Back-Right corner

of the Bot1 tray
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Batch Operations
The Bot1 defines a sequence of operations as a batch. The MVSS software allows the user to create, edit, import, or 
export batches in the software. A batch requires the user to create or have an Analysis method prior to batch creation. The 
available Bot1 batch operations are defined in the following sections. 

Bot1 Sample Analysis
A Sample Analysis operation executes an MVSS method within a batch. A sample analysis requires an Optimize 
Illumination to be performed before the method will be executed. The configurable parameters for a sample analysis 
operation are:

•	 MVSS Method

•	 Sample Analysis Liquid Location

•	 Optimize Illumination Liquid Location

•	 Stirring Cycles/Speed (optional)

Flushing
A Flushing operation is used to clean the flow cell between samples. Typically the user will perform one or more flushes 
of detergent, buffer, or filtered water before executing the next sample analysis or baseline operation. Refer to the User 
Guide for the MFI 5100/5200 Flow Microscope or the MFI Method Development Guide for information on detergents used 
for flow cell cleaning. The flushing operation has the following configurable parameters: 

•	 Fluid Location

•	 Liquid Volume (0.1 – 1 mL)

•	 Flushing Rate (0.1 – 6 mL/min)

Flush at the maximum speed of 6 mL/min to ensure particulates and/or air are completely removed from the system.

Baseline
A Baseline operation is used to determine the cleanliness of the system. It executes a user-specified MVSS method, and 
will compare the results with the specified pass/fail concentration criteria over the given size range. The configurable 
parameters for a baseline operation are:

•	 MVSS Method

•	 Sample Analysis Liquid Location

•	 Optimize Illumination Liquid Location

77

Chapter 8: Bot1 Autosampler  //  Batch Operations

MVSS User Guide



•	 Pass/Fail Concentration 

•	 ECD Size Range

•	 Number of Retries

If the baseline passes, the batch will continue to the next operation. If the baseline fails, the system will attempt to clean 
the system by re-executing the series of flushing operations leading up to the baseline operation. If the baseline fails up to 
the maximum number of retries, the system will halt and a visual alarm will occur. 

Stirring
The Stirring operation is used to re-suspend samples before beginning the sample analysis. The stirring operation has the 
following configurable parameters:

•	 Liquid Location

•	 Stirring Volume

•	 Number of Stirring Cycles

•	 Stirring Rate

While stirring is integrated into the sample analysis operation, it is important to add an additional stirring operation before 
the analysis operation when optimizing illumination using the sample fluid.

Time Delay
A Time Delay operation allows the user to pause the system between batch operations. The delay value is specified in 
seconds.

Dry System
A Dry System operation is used to remove fluid from the system. This is used to minimize flushing steps between dissimilar 
fluid types, and also to reset the volume in the sample inlet port in case of small calibration errors between the pipettor 
and the peristaltic pump. It is recommended to periodically insert a Dry System operation between many successive 
flushes to reset the volume in the port, especially before starting a new analysis.

Batch Creation
A batch is considered to be a sequence of operations that can be executed one or more times. An example sequence of 
operations and volumes for a three-run measurement of 1 mL polystyrene bead samples is given in the table below.

78

Chapter 8: Bot1 Autosampler  //  Batch Creation

MVSS User Guide



In-Sample Optimize Illumination
The Bot1 protocol differs from manual operation by using in-sample optimized illumination to ensure accurate count/
concentration results. The Bot1 contains 50 µL of fluid in the sample port during normal operation. Optimizing in filtered 
water or buffer before starting an analysis will result in this water/buffer potentially diluting the sample. Therefore the Bot1 
Optimize Illumination operation has a built-in purge operation, so that optimizing using sample and following the protocol 
in the table below will ensure accurate count/concentration results. 

T Y P I CA L B ATC H C O N F I G U R AT I O N F O R T H R E E S A M P L E A N A LYS I S R U N O P E R AT I O N S W I T H A C L E A N I N G 
A N D B A S E L I N E CYC L E .

Operation Liquid Volume (mL)

C
le

an
in

g Flush 0.22 μm Filtered Water 0.9

Flush 0.22 μm Filtered Water 0.9

Dry System

Ba
se

lin
e

Flush 0.22 μm Filtered Water 0.9

Optimize Illumination 0.22 μm Filtered Water 0.22

Baseline 0.22 μm Filtered Water 0.7

Dry System

Ru
n 

1

Flush Water/Filtered Buffer 0.9

Stir 3 cycles, speed 5 Sample 1

Optimize Illumination Sample 1 0.22

Stir 3 cycles, speed 5 Sample 1

Analysis Run 1 Sample 1 0.7

Ru
n 

2

Flush Water/Filtered Buffer 0.9

Stir 3, speed 5 Sample 2

Optimization Illumination Sample 2 0.22

Stir 3 cycles, speed 5 Sample 2

Analysis Run 2 Sample 2 0.7

Ru
n 

3

Flush Water/Filtered Buffer 0.9

Stir 3 cycles, speed 5 Sample 3

Optimize Illumination Sample 3 0.22

Stir 3 cycles, speed 5 Sample 3

Analysis Run 3 Sample 3 0.7

Flush 0.22 μm Filtered Water 0.9
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Batch Manager
A batch can be configured using the Batch Management user interface in the System Operation menu. An example of this 
interface is shown below. The general sequence of events when creating a batch is as follows:

•	 Define the modules to be used during the batch

•	 Define the liquid volumes available at each module location

•	 Add operations to the batch

The user can execute the batch or save the batch for later use. Saved batches can be used as templates to create new 
batches. Batches can also be exported in a tab-separated (TSV) text file, and imported into other MFI systems equipped 
with a Bot1. 

Module Details

The Module Details section provides a graphical representation of the Bot1 tray. The user can choose the modules that will 
be used in the batch. Note that the Discard bin is required to be in location 1, and the Pipette Tip Reuse module is required 
to be in location 2.

Batch Operations

The batch operations can be viewed as a menu on the upper right side of the batch protocol interface. Once selected, 
operations can be moved up and down or deleted from the list. The MVSS software will prompt the user to complete the 
required fields before the batch can be executed.
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Liquid Details

This section defines the liquid volumes present in the sample holders and reservoirs specified previously in the Module 
Details section. The user has the option to reuse pipette tips for specified liquids. This is recommended for flushing/
cleaning fluids, such as water or detergents, to minimize the use of pipette tips. The pipette tip reuse module is required to 
be specified for tips to be reused.

Batch/Summary Details

The batch and summary details sections allow the user to name the batch, add notes about the batch, and provide some 
summary statistics on the batch such as the number of tips used, the number of operations, and the estimated completion 
time.

Creating a Batch
A batch is the sequence of operations performed by the Bot1. A workflow diagram of the batch creation process is shown 
below. Users can create, edit, import, or export batches. Once a batch is created or imported, it can be deleted (in MVSS 
version 3.3.0 or higher). Prior to creating a batch, the user must either create MVSS Method(s) or have one available, and 
all Baseline and Analysis operations will require a method.

Add/remove definitions and 
define order

Summary of Batch  
(Run Time, Tips Used, Number of 

Operations)

Define modules

Define liquid volumes and  
locations 

81

Chapter 8: Bot1 Autosampler  //  Batch Creation

MVSS User Guide



Step 1: Batch Creation 

1.	 Create and save a Method for sample analysis.

2.	 In the main menu, select System Operation > Batch Management:

Step 2: Select Type

3.	 The Batch Management window will open and request the selection of a batch type. These options are:

•	 Blank − Creates an entirely new batch

•	 Import − Imports a batch into the repository

•	 Load − Allows using a pre-existing batch from the repository as a template

NOTE: Select Load if you will be running the batch without making edits.
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New batches are blank as shown below. The Batch operations menu allows the user to simply click each operation to add it 
to the protocol list. Click and drag the operation to move it within the method.

Add/remove definitions and 
define order

Define modules

Define liquid volumes and  
locations in header menus

Step 3: Module Details

4.	 In the Module Details screen, use the drop-down menus to assign a module type to each position inside the Bot1 tray. 

•	 Discard bin − Position 1 (required)

•	 Pipette Tip Reuse − Position 2 (required)

•	 Microplates and buffer reservoirs − can be placed in Positions 3–6. 

NOTE: Insert microplates and buffer reservoirs in the Bot1 tray with A1 in the top left corner.
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S E L E C T I N G M O D U L E P O S I T I O N S

V I E W O F E M P T Y (L E F T ) A N D F I L L E D (R I G H T ) M O D U L E S:

5.	 When defining the Liquid Details in the window, note the following:

•	 Liquids cannot be defined until you have placed modules and shown them as filled

•	 Select modules from the drop-down menu 
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•	 Right-click on the cell you want to add liquid to as shown below:

•	 To fill multiple cells, right-click and drag

•	 To remove liquids or add info, right-click the well:

•	 Empty cells will be highlighted in yellow

•	 Filled cells will be highlighted gray when selected

•	 Hovering the mouse over a cell will display its well number:
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6.	 In the Liquid Details Summary window:

•	 Liquids cannot be defined until you have placed modules and shown them as filled

•	 Select liquids from the menu 

•	 Well positions will show “prefilled” to the maximum volume allowed

Step 4: Add Operations

Most operations require user-defined volumes, locations, and parameters. MVSS will notify users if any information is 
missing or volumes are incorrect:
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7.	 Choose batch operations in the Add Operation list. Click, drag, and drop an operation to move it up or down the stack. 

NOTE: Baseline and Analysis operations are the execution of a previously defined MVSS Method.

8.	 In the Batch Operations window:

•	 Use the operations buttons in the Add Operations tab to add steps to the batch 

•	 To delete a step, click the X button

•	 To reorder steps, simply click the step, drag and drop:

•	 To add a step, select a step from the menu at the top of the Batch Operations panel located on the right side of the 
Batch Management screen. The new step will be inserted after the one that was selected and can be moved by 
dragging it to a new location. You can also delete a step by selecting the X button on the right-hand side of every 
step: 
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NOTE: Baseline is for particle background and Analysis is the method you selected for the sample.

•	 To quickly define the sample well used for a step, simply select the well on the plate map and drag it to the batch 
location. You can also use this step for defining the buffer reservoirs to use for flush steps. 

9.	 Repeat operation feature:

The Repeat operation is available from the Batch Operations menu, designed for fast Bot1 batch protocol creation. 
Complex protocols can be finished in minutes by repeating a series of steps for a group of samples. To implement a 
Repeat operation in a new or existing Bot1 batch protocol: 

•	 Add the Repeat operation to the protocol using the Batch Operations buttons. Click the Repeat button. The new 
operation will appear in the protocol. Then just click and drag the new operation to the desired location. 

•	 Next, add the steps that you want to include between the Start Repeat and End Repeat by selecting steps from the 
Batch Operations menu and moving them to the desired location. Select Flush, Optimize Illumination, Stir, Analysis, 
and Dry steps to include within the repeat. Fill each step out as you normally would with volumes, labware locations, 
stir speed settings, and choice of analysis method. 
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•	 To apply samples to the Repeat operation, right-click to select all of the sample wells that you want to include in the 
repeat from the plate map. The wells will change from blue to dark gray once selected. Drag and drop the selected 
wells onto the for Samples box in the Start Repeat step. The for Samples box will update to Samples and the Analysis 
step within the Repeat will also specify Samples. To ensure that you stir your samples and optimize illumination 
correctly, check that the Samples description is shown in the Stir and Optimize Illumination steps as well. The figure 
below shows the final protocol, updated to include the new Repeat group of samples.

10.	Method selection options: 

•	 Click the Browse button to the right of the method window to browse methods:

•	 Select a method from the pop-up list:

•	 Name and save your method, then start the run
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11.	 Final batch view of a completed protocol:

Step 5: Pre-batch Execution Checks

1.	 Verify all microplates and reservoir buffers are in the appropriate location and contain sufficient (excess) volumes as 
indicated in the batch.

2.	 Verify enough pipette tips are available to complete the batch.

3.	 Make sure the Discard bin and Reusable Tip Holder are empty before starting a batch.
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Batch Execution
Once a batch is configured, the batch can then be saved and executed. When the Execute button is clicked, a Batch 
Execution dialog will display, as shown below. This allows the user to add liquid names and notes for each liquid. The 
liquid name for samples is used to name the MVSS project file, allowing users to execute a saved batch multiple times 
to generate unique sample analysis data sets. The user can choose a path to save the project files generated from the 
batch. Methods which have a predefined root folder will ignore this path and save the project to the folder specified in the 
method. 

Be sure to define the project path for the file so that the file name length is kept to a minimum and enables file import. 
If you do not specify a project path for the file before you execute the sample run, your data may not be accessible for 
further analysis.

Batch Progress/Results
During the execution of a batch, a Batch Progress window will display as shown in the figure below. The progress of each 
batch operation is highlighted during the execution, with successfully completed operations marked in green, in-progress 
operations in yellow, and failed operations in red. On completion of the batch, the user can select the analysis operations 
in the list, select the Analysis Report tab, and click View Report to launch the report for the analysis run. 
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This batch summary dialog can be viewed later by selecting System Operation > Batch Execution History and selecting 
the batch name and date the batch was executed. 
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Importing and Exporting Methods and Batches

Importing Batches
MVSS versions 3.3 and higher allow the import of projects or batches from version 3.1 or higher. From the main menu, 
select File > Import > Methods or File > Import > Batches. Browse for the files and select the ones to be imported.

Exporting Methods and Batches
MVSS versions 3.3 and higher also let you export and then delete methods and batches. From the main menu click 
File > Export > Methods or File > Export > Batches. Select the files for export, and then check the Delete methods after 
the export checkbox: 
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User Account Permissions
You can edit user account permissions. User account permissions can now be edited. To do this, from the main menu click 
User Account > Edit User. Select or deselect features to enable or disable for specific user accounts:
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Chapter 9:  

Troubleshooting

Chapter Overview
•	 Frequently Asked Questions
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Frequently Asked Questions

Where do I get the latest update for MVSS?

MVSS software is available for purchase by contacting a ProteinSimple sales representative. Changes to the software 
revision can be found in the software release notes or in the README file found on the CD or FTP site. Please see Chapter 
2 for details on installing the software.

How do I back up my data?

Data can be backed up from the repository by following the procedures outlined in ”Export Single or Multiple Projects” on 
page 22. Note that data needs to be exported in binary mode in order to be re-imported into MVSS and to maintain 21 
CFR Part 11 compliance. 

It is recommended that data be backed up daily to protect against data loss.

The software tells me the instrument/camera is not detected. What do I do?

If the software reports that the camera is not detected, check the Firewire connections on the instrument and PC by 
disconnecting and reconnecting the Firewire cable. Verify in the Windows Device Manager that the Firewire camera driver 
is correctly installed by ensuring the driver under Imaging Devices is set to “OEM Firewire Camera Release 4”. 

If the software reports that the instrument is not connected, check cable connections between the PC and the instrument. 
For MFI or MFI with Bot1 systems, verify that the COM port settings are correct for the instrument by comparing the 
Hardware Settings (page 27) menu settings with the system COM ports reported in the Windows Device Manager.

If the issue persists or for more information, please contact ProteinSimple Service for additional troubleshooting steps.

My baseline counts are too high. How do I improve them?

Maintaining the cleanliness of the inlet port, tubing, and flow cell is an important part of achieving low baselines. The 
instrument should be cleaned properly and components replaced on a regular basis as outlined in the Maintenance section 
of the Instrument User Manual. For protocol tips for achieving low baselines, please see the Baselines section of the Good 
Operating Practice chapter in the Instrument User Manual.

Particles are sticking to the flow cell during a run

Proper cleaning of the flow cell can reduce the propensity for particle sticking, as outlined in the Maintenance section 
of the Instrument User Manual. If the flow cell is properly cleaned but stuck particles are still occurring, this may be an 
indication that the flow cell coatings have degraded, or the coating may be inappropriate for the sample type. Please 
contact ProteinSimple Service for information on available flow cell options. 

MVSS software has the ability to remove stuck or slow-moving particles from the entire particle population of a sample. 
Please see the instructions in “Analyzing Multiple Samples” on page 40. MVAS and Image Analysis software also have 
a feature to remove duplicate particles from a measurement run. Please see the MVAS or Image Analysis User Manuals for 
details on how to use this feature.
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How do I open my data in MVAS?

Data can be exported to MVAS in two ways. First, an individual run can be exported using the Copy Run Data functionality 
when viewing reports or images, as outlined in the “View Menu” on page 24. Second, complete projects can be 
exported from the repository in non-compliant mode (CSV/JPG/PDF format) as shown in ”Export Single or Multiple 
Projects” on page 22. Both of these operations will export the run data in CSV format, which is appropriate for creating 
an MVAS project.

How do I open my data in Image Analysis?

If Image Analysis is installed on the MFI computer, it can be launched directly from MVSS by selecting 
System Operation > MFI Image Analysis. When running in this mode, Image Analysis has direct access to all of the 
projects in the repository and can be opened using File > Open > Project in the Image Analysis software package. 
Complete projects can be exported from the repository in non-compliant mode (CSV/JPG/PDF format) as shown in ”Export 
Single or Multiple Projects” on page 22. Exported project data can then be opened using File > Open > Browse (CSV) in 
the Image Analysis software package. 

How do I optimize my protocols for analysis? 

For information on how to optimize a method on an MFI or MFI with Bot1 system or for applications-specific information, 
please refer to the MFI Method Development Guide.

Handling Errors When Creating a Bot1 Batch Protocol

I get an error when I try to edit an existing Bot1 batch protocol.

Try editing the name of the batch so it uses a new name. If the batch name already exists, the software will prompt you to 
change the existing batch name so you don’t overwrite it. Here’s a more detailed explanation of how to select, edit, and 
create new batch protocols: 

Select Batch Management from the main menu. The following window displays:

•	 Blank: Creates a new, empty batch with no name

•	 Import: Creates a new batch from imported file contents

•	 Load: Lets you choose an existing batch to load
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Each batch has its own unique name:

•	 Only one batch can be open at a time

•	 The batch name must be unique

•	 Users can save, load, and create new batches

A batch cannot be saved until a batch name is entered:

•	 Batches can be saved with errors for later editing

•	 Batches with errors cannot be executed 

NOTE: If a batch with the same name already exists, the software will prompt you to change the existing batch name 
so that you don’t overwrite it.

I want to modify the module details for liquids and pipette tips in my batch protocol, but I’m not sure 
what the steps are. 

You can create and edit a batch in any order. There are two primary areas to focus on for liquids and pipette tips:

•	 Module Details (1–6): Shows the modules and liquids available for the batch. This is a direct representation of your Bot1 
deck layout.

•	 Operations List: List of operations that the system will perform, in chronological order, during the batch execution.

1.	 Use the menu above each location in the Module Details to specify which modules are where:
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2.	 Add liquids to the modules by selecting a cell: 

•	 Ctrl-click to select/deselect individual cells that contain the samples of interest.

•	 Shift-click to select rectangular sections of cells containing a group of samples.

3.	 Select Add Liquid:

The Add, Remove, and Select All options let you add bulk liquids without having to select each individual cell.

4.	 Enter the liquid details:

After details are entered, the cell will turn blue. Rolling over the cell with the mouse will display the liquid details:

•	 White cells: Indicate no liquid has been loaded

•	 Light blue cells: Liquid loaded, but not used in any operations yet

•	 Dark blue cells: Liquid loaded and being used in an operation
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5.	 To view liquids used during batch execution, click Liquids in the Batch Management window:

The Liquid Details box will display under Module Details and allows you to view and edit the names of liquids, their 
volumes, and locations. 

I want to modify the operations for samples to create a batch protocol, but I’m getting errors. 

If you see errors similar to what is shown below, you still need to fill in step information. Be sure to define which liquids you 
want to use, the baseline limit for particles, and the number of retries that will be allowed for the particle baseline.
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What’s the best way to create a Bot1 protocol? 

Try the following sequence to add steps to the Operations List and create a Bot1 protocol. The Operations List is a list of 
operations the system will perform, in chronological order, during the batch execution.

To add operations:

1.	 Click on a Batch Operations button:

•	 The operations that draw the fluid are displayed on the right side of the protocol

•	 Users can label the liquid in this window (Flush, Sample1, etc.)

•	 Liquids can be entered in location format (3:B2) if desired

•	 To move liquids from the tray to the input box, just click, drag, and drop them on the step in the Operations window

•	 Click, drag, and drop operations to reorder them if needed (the up and down arrows cannot be used to reorder 
operations).

NOTE: Red text indicates an error. You must fill in the highlighted values to correct the error.

2.	 After you’ve defined the steps in the batch, make sure you’ve defined the liquids used in the batch protocol as well (see 
page 98 for more information). You can review defined liquids by selecting Liquids from the Batch Management 
window menu, and you will see the summary of current liquid sources.
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3.	 Review and check your batch in detail. Did you fill everything in including available sample volumes? If a step wasn’t 
configured completely, an error will display:

4.	 Finally, fill in any details about the batch in the Additional Notes field in Batch Details if needed. The Batch Details box 
is located under the Module Details window. 

5.	 Save the batch. If you plan on running the batch, make sure you have all the needed resources on the Bot1 deck and 
that the door is closed.

6.	 Execute the batch.
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Appendix A:  

End License Agreement

IMPORTANT-READ CAREFULLY:

This ProteinSimple End-User License Agreement (EULA) is a legal agreement between the purchaser (either an individual 
or a single entity) and ProteinSimple for the ProteinSimple MFI View System Software (MVSS) product which may include 
associated software components, media, printed materials, and “online” or electronic documentation. The purchaser 
agrees to be bound by the terms herein. If the purchaser does not agree to the terms of this EULA, the purchaser is not 
permitted to install or use MVSS. MVSS is protected by copyright laws and international copyright treaties, as well as other 
intellectual property laws and treaties. MVSS is licensed, not sold

1. GRANT OF LICENSE

MVSS is provided with a SINGLE USE LICENSE which grants the purchaser the right to install and use MVSS for use on a 
single computer connected to an MFI or DPA instrument. The purchaser may make backup copies of MVSS for backup and 
archival purposes. In the case of a time-limited version, the purchaser is not permitted to use MVSS after the expiry date 
designated in the time-limited version. Time limits are stipulated in your purchase/lease/loan contract with ProteinSimple if 
applicable.

2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS

Maintenance of Copyright Notices: The purchaser must not remove or alter any copyright notices on any copies of MVSS. 
Distribution: The purchaser may not distribute copies of MVSS to third parties.

Distribution: The purchaser may not distribute copies of MVSS to third parties.

Prohibition on Reverse Engineering, Decompilation, and Disassembly: The purchaser may not reverse engineer, 
decompile, or disassemble MVSS or create any derivative works thereof.

Rental: The purchaser may not rent, lease, or lend MVSS to third parties. 

Transfer: The purchaser may permanently transfer all of their rights under this EULA to third parties, provided the recipient 
agrees to the terms of this EULA and ProteinSimple receives prior written notice of such transfer and consents to same. 

Support Services: ProteinSimple may provide the purchaser with support services related to MVSS (“Support Services”). 
Any supplemental software code provided to the purchaser as part of the Support Services shall be considered part of 
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MVSS and subject to the terms and conditions of this EULA. With respect to technical information the purchaser provides 
to ProteinSimple as part of the Support Services, ProteinSimple may use such information for its business purposes, 
including for product support and development. ProteinSimple will not utilize such technical information in a form that 
identifies the purchaser. 

Compliance with Applicable Laws: The purchaser must comply with all applicable United States, European Union, or 
Canadian laws regarding the use of MVSS. In particular, the purchaser agrees that the purchaser will not export or re-
export MVSS to any country, person, entity, or end user subject to United States, European Union, or Canadian export 
restrictions.

3. TERMINATION 

Without prejudice to any other rights that ProteinSimple might have, ProteinSimple shall be entitled to terminate this EULA 
if the purchaser fails to comply with any of the terms and conditions of this EULA. In such event, the purchaser shall cease 
all use of MVSS and destroy all copies of the same

4. OWNERSHIP

All titles, including but not limited to worldwide copyrights, in and to MVSS and any copies thereof are owned by 
ProteinSimple or its designees. All title and intellectual property rights in and to the content which may be accessed 
through the use of MVSS are the property of the respective content provider or owner and are subject to applicable 
copyright or other intellectual property laws and treaties relating to the content. This EULA grants the purchaser no rights 
to use such content, save as is expressly provided herein. All rights not expressly granted are reserved by ProteinSimple.

5. U.S. GOVERNMENT RESTRICTED RIGHTS 

MVSS is provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject to restrictions 
as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-
7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software Restricted Rights at 48 CFR 52.227-19, as 
applicable.

6. NO WARRANTIES

MVSS and any related documentation are provided “as is” without warranty of any kind, either express or implied, 
including, without limitation, the implied warranties of merchantability, fitness for a particular purpose, or non-
infringement of third-party intellectual property rights. ProteinSimple expressly disclaims any warranty whatsoever for 
MVSS. The entire risk arising out of the use or performance of MVSS remains with the purchaser.
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7. LIMITATION OF LIABILITY 

ProteinSimple shall not be liable under any circumstance for any special, incidental, indirect, or consequential damages 
whatsoever (including, without limitation, damages for loss of business profits, business interruption, loss of business 
information, or any other pecuniary loss) arising out of the use of or inability to use MVSS, the provision of or failure 
to provide Support Services, the breach of any provision of this EULA, or the negligence or gross negligence of 
ProteinSimple or its directors, officers, or employees, even if ProteinSimple has been advised of the possibility of such 
damages. In any case, ProteinSimple’s entire liability under any provision of this EULA shall be limited to the greater of 
the amount actually paid by the purchaser for MVSS or US$5.00. Because some states and jurisdictions do not allow the 
exclusion or limitation of liability, the above limitation may not apply to the purchaser.

8. MISCELLANEOUS 

This EULA is governed by the laws of the Province of Ontario, Canada. If this product was acquired outside Canada, then 
local law may apply. Should the purchaser have any questions concerning this EULA, or if the purchaser desires to contact 
ProteinSimple for any reason, please contact

ProteinSimple 
115 Terence Matthews Crescent, 
Ottawa, Ontario 
K2M 2B2 
Canada

(613) 591-7715 (phone) 
(613) 591-7716 (fax)

email: support@bio-techne.com 
Web: www.bio-techne.com
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